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Installation Instruction 

Important Information 

Directory Synchronization 
For directory synchronization applications, e.g., roaming profiles, etc., please note that you must close STRAKON and 
all open drawings before synchronization to avoid data loss. Alternatively, exclude the STRAKON directory of open 
drawings version.2024\strakon-workdir (see Installation paths) from synchronization if you always want to close 
STRAKON with open drawings. 

Installation Requirements 
64-bit OS: > Windows 8.1 SP1 
Screen resolution: 1920 x 1080 (recommended) 
 min. OpenGL version 3.2 
If the Setup program does not find the runtime libraries for Visual C++, it offers their installation, which you must 
perform as a User with administrator privileges. 

Installation Important 
The separate installation is carried out independently of the later STRAKON user, i.e. it can be carried out by an 
administrator account. In addition, to install user data, choose whether to install it separately for each user or for all 
users. 

User data separated for each user 
After the program data has been installed, the user's user data for the user's user account are automatically reinstalled 
during the first start of STRAKON in the context of an initial setup. This operation does not require administrative 
permissions for the user. 

User data for all users 
During installation, the program data including user data are installed. All STRAKON users access the common user 
data later via their user account. 

If STRAKON is only required for a single user on the computer, the installation can be performed directly from the 
user's account, but with administrative authorization. 

Installation with a custom installation path is no longer supported.  

Installation Paths 
Program Files: C:\Program Files\DICAD\Version.2024 
User data disconnected: C:\Users\<USERNAME>\AppData\Roaming\DICAD\Version.2024 
User data for all:  C:\ProgramData\DICAD\Version.2024 
Open drawings separated: C:\Users\<USERNAME>\AppData\Local\DICAD\Version.2024\strakon-workdir 
Open drawings for all: C:\ProgramData\DICAD\Version.2024\strakon-workdir 

DICAD 2024 Program Group 
Regardless of the type of installation selected, the DICAD 2024 program group with all entries is available to every 
user in the Windows Start menu after installation. 

Prerequisite for an update: 
Updates are only possible with the same selection of installed user files. 
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Installation 
Start the installation by clicking setup*.exe and select the language version to be installed (this will appear if you are 
performing a first and parallel installation).  

Initial Installation 

 

Install STRAKON for all users 
Select whether to install the user data separately for each user (AppData\Roaming\DICAD directory) or once for all 
users (directory C:\ProgramData\DICAD). 

When installing separate user data, the user retrieves the user information when the user starts STRAKON for the first 
time. Each user should define their own unique user name. When installing user data for all users, the first start of 
STRAKON makes the query once by the first user, i.e. all other users have the same user name in STRAKON. 

 

This username is sometimes used for various locks in the STRAKON, e.g. drawing being processed etc. 
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Update / Parallel Installation 

 

Parallel installation 
Select whether to install the user data separately for each user or for all users. Optionally, settings from an installed 
STRAKON version 2023+ can be adopted. 

To be applied: 
plotter/printer drivers (*.use only except standard*.use, plotter.ger and sysfplot.ini) and redirection files, 
tablet configuration, screen layout, layer sets, colors, editor setting, 
Excel template files, images from template folders, input dimensions, text blocks, 
company header, backup file (secur.sic), data export settings (PPS, BVBS, etc.), 
preset sets, mapping files for DWG/DXF import/export, 
Settings of the dialog for backups, unitisation (all SYS files), 
Auto Snap settings einbau-s.dat for PPS export, 
master data management strasys.ini, 
design mesh and settings definition files from the Settings > General settings menu. 

All files are copied locally to the 2024 version home directories. 

Update installation 
Select the version on which to install STRAKON 2024. All files are copied only to the local default folders, e.g. embed-
ded parts to ..\ebt. 

Place a STRAKON 2024 link on the desktop 
Switch this option if you want the program link to STRAKON 2024 to be created on your desktop for all users. 

Installing additional files for the semi precast parts module 
Switch the option to install additional files that are required specifically for the semi precast parts module, such as 
reinforcement categories and view box templates.  
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De-Energizing  

Dongle Version Enable 
A version release for the dongle in the service is usually not necessary! 

Check the version number in the dongle from Start > Programs > DICAD 2024 > Dongle test:  

 

If a version number < 2024 is shown in the highlighted line, request release for the dongle. 
Open the activation via Start > Programs > DICAD 2024 > Unlock modules: 

 

Click the Request button, fill in the fields, and submit the request to the appropriate sales representative. 
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Module Enabling for the Computer 
Modules, e.g. steel construction, etc., can be activated via an unlock key only for the computer.  
Open the activation via Start > Programs > DICAD 2024 > Unlock modules: 

 

Mark the modules, click on >> and Request, fill in the input fields and send the request to the responsible sales mana-
ger. 

 

Register Unlock Keys 
After receiving the unlock key, open the activation via Start > Programs > DICAD 2024 > Unlock modules, type the 
unlock key in capital letters and click Register on. 

We wish you continued success in your work with the 2024 version! 

Please do not hesitate to contact us if you have any questions. 

Your DICAD Support Team 
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Important Information about Version 2024 

Please read this information before updating to STRAKON 2024 or editing existing drawings / projects from STRAKON 
<2024 with this version. 

"3D segment drawing" is no longer possible 
From STRAKON 2024, it is no longer possible to open drawings of the 3D segment edit mode. The associated functi-
onalities such as 3D segment, level etc. are no longer available. 

Database jump to version 2024 
For version STRAKON 2024 it enters a database jump for various important STRAKON data (drawings, Flex-Parts / 
3D embedded parts etc.), i.e. these data are no longer compatible with STRAKON <2024 after reading or edits in 
STRAKON 2024. If you are working on projects with multiple users, please consider whether you finish the project in 
the previous version of STRAKON or directly update all STRAKON computers of the project participants with STRAKON 
2024. This also applies to the data transfer to external STRAKON suppliers. 

Transition to Python 3 requires customization of own additional programs 
Own additional programs written in Python must be adapted by the user to the valid Python 3 syntax. 



 New Features STRAKON 2024 

 Configurations 

 

9 

Configurations 

Settings 

Sync Cloud: Central Folder for "strako.db" 
To work together in a file synchronization cloud, such as SharePoint, NextCloud, or OneDrive, you can now determine 
a central folder for the strako.db drawing administration, regardless of project data, that is not synchronized via the file 
synchronization cloud. 

The prerequisite for this central folder is that the strako.db is located in a directory on the server or on a computer to 
which all users have full VPN access, regardless of the file synchronization cloud. The other data of the STRAKON 
workspace (project) are located in the cloud and as a copy locally on the computer of each user, which are automatically 
synchronized on an ongoing basis. 

In order to allow everyone to access this central directory via VPN, each user enters the VPN path for cloud drawing 
administration (menu Settings >  General settings > chapter General settings) the path on their computer in which 
the drawing administration strako.db is located. This path is the root directory. 

 

You can enter this path, for example, as a network path via a UNC address \\hostname\folder\subfolder or by spe-
cifying a substituted drive letter, for example L:\, under which a network folder is assigned. 

 

Important! 

For the new setting to be saved correctly after entering the VPN path and confirming with OK, you must close and 
restart STRAKON. 

 

TXT file directory_depth.txt 
Because the structure of a workspace is always different and the resulting directory depth cannot be predetermined, 
you must set the directory depth in the TXT directory_depth.txt file by a value, such as 2, to map the tree. 

Save a this file in your root directory. It is important before creating a new workspace that you create this file with the 
desired directory depth. It is not possible to change the directory depth later. 
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If the directory_depth.txt file does not exist, it is automatically created in root directory and preassigned with directory 
depth 1. 

Important! 

Also, a change to the directory_depth.txt file requires a restart of STRAKON to save the new setting correctly. 

 

If you create a new project now, when you query for the management file, the new option Create plan management 
separately from the workspace (for file synchronization cloud) also appears: 

 

If you have not specified a VPN path, this option does not appear. 

Switch this option to place the strako.db drawing administration separately from the workspace in the central folder 
you specify (see VPN path for cloud drawing administration option). 

Example: 
Select the ..\halle\decke directory for the new workspace. Now the VPN path \\nas0\support2\planung, which you 
have set and which is the root directory, automatically places the drawing administration strako.db into the directory 
\\nas0\support2\planung\halle\decke. 

strako.db is centrally located below the predefined VPN path: 
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The other project data is located locally on the computer as well as in the cloud in the workspace: 

 

In addition, the file _CLOUD-STRAKODB_ is now created in the directory of the workspace. In this file the path of the 
workspace on your computer is entered, e.g. halle\decke\ 

 

Together with the entry of your VPN path (see the VPN path for cloud drawing administration option), this results in 
the complete mapping of the network path to strako.db for this workspace, e.g. 
\\nas0\support2\planung\halle\decke 

Since the workspace on your computer is constantly automatically synchronized from the cloud, when another user 
accesses it, the location of the strako.db drawing administration can be automatically ascertained. 

Note: 

Note that it is not possible to separate the drawing administration from the workspace. 
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Master Data Renamed / Expanded 
Under the 3D design category, the Labeling/data container templates item has been renamed to Data manage-
ment/labeling templates. Lets you determine the root data name and path for label/data container templates, property 
sets, and export filters. 

 

Material Administration: Space in Material Group 
Spaces are not allowed in the name of the material group, so they will now be replaced with underscores after a 
message is displayed: 

 



 New Features STRAKON 2024 

 3D - Modeling 

 

13 

3D - Modeling 

Cube 

General 

Tab Renamed / Expanded 
The BCF tab has been renamed BIM and expanded with the Data management group (see "BIM" Tab, page 16). 

 

Accessibility 

New Key Commands 
The following key commands have been added to the View tab (see also New Key Commands in the reinforcement, 
page 37): 

[Shift] + [1] Save current scene (view/section, display + zoom) 
[Shift] + [2] Load scene 

"Objects" Tab 

Path and Blend Generation Adjusted / Profile Alignment Expanded During Insert 
The 3D route property has been removed from the object data of a path and also from a 3D route, which can be 
inserted through the Bridge/Tunnel Designer. In order to continue using this functionality, the Profile function has been 
expanded. When placement a profile, you can now align the profile parallel to the z-axis by turning on the new icon 
Align profile parallel to global z-axis on path in the additional toolbar when starting up the path. 

Additional toolbar 
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When off, the function is inserted orthogonally to the path. 

 

The Blend function has also been expanded by a function. By turning on the new icon End faces parallel to the global 
z-axis, the blend is generated with its end faces parallel to the z-axis. 

Additional toolbar 

 

 

When the function is turned off, the blend is created with its end faces orthogonal to the path. 
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The object data of the blend  show whether the function was switched on or off when the blend was create, for infor-
mation about the property End faces parallel to the global z-axis. 

 

Arc: Machining via Handles Extended / Unified 
Editing a 2D object Arc over the handles has been unified in Cube and Cube view. In addition, three additional handles 
have been added for editing an arc. You can change the diameter or flip it as the end points are moved using the new 
cone handle in the center. 

 

You can lengthen or shrink the arc using the conical handles on the end points. The diameter remains intact. 

 

In Cube view, you work with handles for the arc comparatively. 
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"Shuttering Boards" Tab 

Screw Connection also Possible at T-Joints 
A screw connection as a connector is now also possible at a T-joint. 

 

"BIM" Tab 

IFC Data Management: Using Property Sets 
In open BIM projects, it is necessary for a BIM model to contain project-specific property sets and for the object pro-
perties to be associated with these property sets (P-sets). In so-called AIAs (client information requests), the client 
determines which property sets with which properties should be used for which objects and components in a project. 
As a result, this must be transfer into an IFC model file. 

The IFC data management functionality enables STRAKON to define individual property sets and assign properties of 
objects and components to them. Thus, individual requirements on the part of the client can be mapped in AIAs with 
STRAKON. The resulting IFC data are then adapted to the respective AIA requirements.  

You can also use the STRAKON data management to control object and component properties in such a way that only 
certain properties are transferred to specific project partners via IFC. Internal data thus remain internal. 

Changes in the property set, e.g. new property set, delete property set, etc. directly affect existing 3D objects with the 
associated part type. 

Determine property sets using the BIM tab > group Data management > function Property sets. 

 

Edit Property Sets 
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After clicking on the function, a dialog box will open to create or edit property sets and determine properties: 

 

 New Property Set 
Create property set 
In the dialog box that opens, enter the name for the new property set, e.g. 

 

The letters A to Z (upper and lower case), numbers, and underscores are allowed as you type. Note that 
the name cannot start with a number. 

The name of the property set is considered an ID, which uniquely identifies the property set. 

 

If you confirm the entry of the new name, this name is automatically used as the description. 
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 Edit current set properties 
Add properties for the current property set 
The property name is the identifier for the IFC file and its description text will appear in the data container 
later. Also note that only letters A to Z (upper and lower case), numbers and underscores are allowed! 

 

If you confirm the entry of the properties with OK, these properties will be displayed to the property set. 

All 3D objects with the appropriate part type (see Assigned part types option) are then assigned these 
properties from the property set. 

In the object data, the property sets are appended with their respective properties: 
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 In the tooltip, the properties from the respective property sets are listed at the end of the object properties. 

 

 Delete the current set 
Delete the currently selected set directly. 

Property Set 
Select property set from the drop down list: 

 

The text of the description is also displayed in parentheses after the name. 
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Properties 
Description 
Description text for the property set, which you can change as you wish 

Assigned part types 
Assign part type(s) to the property set 

 

Properties 
Display of all assigned properties to the selected property set 

 

The property set file user-property-registry.json is placed in the stored master data path of the data management/la-
beling templates (annotation). 
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IFC Data Management: Applying Property Sets / Properties Export Filter 
When export IFC in the Cube (tab File > Save as as IFC file), you can now use the export filter to exclude property 
sets or only certain data from this set, i.e. the data transfer are not save as.  

In principle, in the case of an export IFC, the properties are listed separately in the IFC file for each property set. 

To open the export filter, go to the BIM > group Data management > function Export filter tab. 

 

Call export filter 

 
After clicking the function a dialog box will open, in order to create/edit export filters: 

 

 New export filter 
Create export filter 
In the dialog box that opens enter the name of the new export filter, e.g. 

 

Confirm the new name. The export filter will be opened directly, its name will be displayed in the dialog 
title bar. 

You can then add property sets to this export filter by clicking the Add property sets button that are not 
supplied during export IFC. 
 

 Open export filter 
Select export filter for further processing 

 

 Save export filter 
Save the currently open export filter 
The dialog box stays open for further editing. 
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 Save export filter as 
Duplicate the currently open export filter with a new name 

 

 Delete export filter 
Delete the currently open export filter: 
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 Add property sets (selected sets are not exported) 
Add property sets to the previously created export filter (see New export filter) or to the opened export 
filter (see Open export filter), which are not supplied by the export IFC 
A dropdown list with the property sets appears.  

 

 Once selected, the selected property sets are transfer in the export filter.  

The Exported properties column shows the number of properties in the property set excluded from the 
export filter (see Exclude properties of selected property set from export filter icon). 

 Remove selected property sets 
Delete property sets in the currently open export filter 
Select the property set and click the icon. The property set is deleted directly. 
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 Exclude properties of selected property set from export filter 
Although a property set is excluded from export, you can select individual properties from this property 
set that will be exported anyway. 

 

 

The Exported properties column now indicates that some properties in the property set are excluded 
from the export filter, so these properties are transfer during export IFC. 

Click OK to save your entry in the selected export filter and close the dialog box. 

The export filter file export-filters.json is placed in the stored master data path of the data management/labeling 
templates (annotation). 
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If you then carry out an export IFC, e.g. in Cube (tab File > Save as as IFC file), you will be offered a selection list with 
the export filters. Alternatively, you can use the Do not use an export filter option to pass all the data during export. 

 

Create Stairs 

Riser Quantity Changes: Cube Reinforcement in the Head of Stairs Adjusts 
If the quantity of the risers changes with a new height of the flight, the reinforcement in the head of stairs will now be 
adjusted. The reinforcement attached to the head of stairs at the top two steps is retained. 
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Project model 

General 

Ribbon / Tabs: Structured 
The functions of the Cube views have been moved from the ribbon on the left edge of the Cube model window to the 
new tab Cube views (see Cube Views Expanded, page 26). 

  

Cube Views Expanded 
The following features are now available on the new Cube views tab for working with Cube views through the icons: 

 
New Cube view 

 
Edit Cube view exclusively 

 
Edit Cube view data / rename folder 

 
Configure Cube views / folders 

 
Export to drawing as 3D view 

The Cube views are now listed in a tree structure. This tree displays only the Cube views and folders that contain the 
Cube views that are relevant to this drawing, that is, it displays a plan-specific representation of the Cube views. 
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New Cube view 
To create a new Cube view, the Cube view's data have been expanded: 

 

You can now determine an additional description for the Cube view and assign a folder under which the new Cube 
view will be placed. The description will then appear in the tree as a tooltip. 

 

A selection dialog will open to assign the Cube view to a folder. You can also create new folders and delete an empty 
folder in the dialog. If the top item Cube views  is selected, the Cube view is not assigned to any folder. 

 

The Cube views below a folder are shown inversely and cannot be selected. 

The folder where the Cube view is located is displayed. If parent folders are entered, they are also displayed in paren-
theses after the folder name: 
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You can also add the folder for the new Cube view directly to the Cube view's data dialog by first selecting it in the tree 
view and then clicking the New Cube view icon: 

 

The edit of Cube views, e.g. to enter dimensions and datum level in the respective view, is now done via the Edit Cube 
view exclusively icon. 

Edit Cube view data 
To edit a Cube view, select it and then click the Edit Cube view data / rename folder icon. 
You can change the data of the Cube view, such as its name and description, and select a different folder. 

 

 
Rename Folder 
To rename a folder, select it and then click the Edit Cube view data / rename folder icon: 
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Configure Cube views / folders 
The new Configure Cube views / folders function opens the Cube views configuration page to help you keep track 
of the many Cube views and folders that exist in your project. 

You can create a new folder, a blank folder, i.e. without Cube views, by clicking on the icons or the context menu. You 
can also drag and drop a Cube view from one folder to another, and reorder the sequence of the Cube views within the 
folder. 

 

Similarly, from all the Cube views in your project, you configure the views or folders to display in the tree structure. In 
the tree structure, you then activate the views whose 2D objects, such as dimensions and texts, you want to display in 
the Cube model.  

 

 New folder 
Create folder 

In the dialog box that opens enter the name of the new folder. 
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 Delete selected folder 
Delete empty folder 

The icon does not become active until you click on a folder that does not contain a Cube view. 

 
Delete Cube views 

 

A schedule of all Cube views in the project is displayed. Each Cube view is listed with its data. In addition, 
the Affiliation column shows in which drawing the Cube view is used. Several drawings are listed in a 
row. You will only receive a schedule save with the current affiliation after the drawing's date. 

You can only delete a Cube view if it is not associated with a drawing. The line is black. Holding down 
the [Ctrl] button, you can also select multiple times. Confirm the selection with OK and answer the follo-
wing message: 

 

Thereafter, the Cube view from the tree structure is omitted. 

 Export to drawing as 3D view 
Put the Cube view in its saved representation (view or section) as a 3D view into the drawing without 
opening the exclusive processing. 
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Cube View: Edit Cube Views Exclusively  

Tab Expanded  
The Edit tab has been expanded in the group Change by the function Link (see Delete/Correct Dimension Points 
Without Connection, page 32): 

 

Dimensions Without Connections Remain Intact 
When a dimensioned feature is deleted, the dimensions are retained without binding and are highlighted in red in both 
the Cube view and the model or 3D view in the drawing. You can remove or correct these dimensions using the Link 
function. 
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Delete/Correct Dimension Points Without Connection 
To see directly if there are dimensions without a connection in a complex Cube view, use the new Link function (tab 
Edit > group Change).  

 

Delete/correct dimension points without association 

 
Clicking on the function will check all measurements for faulty measurement chains. 

 

A notice will appear in the status bar showing the quantity of the defective dimension chains and the dimension points 
that are no longer connected. 

 

The additional toolbar can be used to correct erroneous measurement chains. 

Additional toolbar 

 

 Delete dimension points without connection 
The unconnected measurements are deleted and the dimension chains are automatically corrected. 
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 Manually correct dimension points without association 
First, you can trap several of the object points marked in red by dragging a section or select a single 
object point by clicking on it. Then determine the new connection point.  

 

 Automatically correct dimension points without binding 
If you switch this function, the dimension points will be automatically corrected, i.e. the connection 
points will be reassigned if further connection points lie in the viewing direction. 

Example: 
A wall opening containing the connection points of the measurements has been deleted. If the auto-
matic control is switched on, the program checks whether there are further points in the viewing di-
rection to which the measurement can be connected. If object points are found, they are automatically 
assigned as new connection points. 

 

Note that the input view must be fixed for an automatic connection (see function Lock view). 
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After mapping, a message is displayed: 

 

If you confirm this information, the dimension chain will be displayed without incorrect dimensions.  

A new check with the Link function then indicates in the status bar that no faulty dimension chains have been found. 

Move Dimension Text 
You can now move dimension texts in the Cube views by help the handles. Switch Grip points and select the dimension 
chain. The handles are displayed for all dimension texts. 

 

Select the dimension text from the grid point and reposition it. If a dimension point is deleted/inserted for this measure, 
the item of the new dimension text is set back to the default position. 

Dimensioning the Lines in the Cube View 
You can now also select the end points of lines, such as a polygon, circle, and arc, for the dimension (group 2D objects 
> function Dimension).  
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Dimensioning the Axes in the Cube View 
You can now dimension an orthogonal axis grid in the plan view of a Cube view (group 2D Objects > function Measure). 
To do this, drive the end points of the axle grid. Notice that the alignment grid is not cut. 

 

Visual Representation of the Axes in Each Cube View Determine 
You can now determine the visual representation of the axes for each Cube view, i.e. you can use different linestyles 
for the axes in each Cube view and also make the labeling different. 

If you have created a new Cube view, the presentation of the axle grid is first taken from the Cube. In the Cube view, 
you can customize this appearance in the View box. For this purpose, the settings of the axle grid have also been 
extended by options: 
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You can now also select the extent of the axes determine from the entity in the X and Y directions, and the label 
position, right or left, from both sides of the Cube view, or none. The supernatant value is the actual dimension on the 
plotted drawing. 

If an object is outside the grid, the projection of the axes refers to the outermost edge of the object of the Cube view 
and not to the intersection of the axes. 

 

As you determine the settings, the grid of axes adjusts accordingly in real time. 
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Cube Reinforcement 

General 

Tab Expanded 
The Rebar and Meshes tabs have been expanded with the Rename function in the Special meshes group (see 
Rename Special Mesh Afterwards, page 40): 

 

Accessibility 

New Key Commands 
The following key commands have been added to the Rebar and Meshes tabs: 

Rebar 
[1] Create and lay rebar as individual bending shape 
[2] Insert and lay rebar as standard bending shape 
[3] Create laying in an area 

Meshes 
[4] Create and lay mesh as individual bending shape 
[5] Insert and lay mesh as standard bending shape 
[6] Create laying in an area 

Rebar / meshes 
[7] Modify concrete cover using an area 
[8] Edit / add / delete hooks 
[9] Edit leg lengths of free legs  
[0] Edit laying 

[Ctrl] + [K] Copy layings 
[Ctrl] + [Shift] + [K] Copy with auxiliary object 
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Rebar 

Input Rebar: Leg Modification / Hook Input With Optical Marking 
When creating a bending shape with leg modification and hook input, you now receive visual support for this, as well 
as for the subsequent modify of the legs or hooks. If the query is made after the leg modification, the input field for the 
initial leg length is automatically active. The leg to be corrected is highlighted in blue, and an arrow indicates the direc-
tion of the change in length. The remaining legs of the bending shape are temporarily displayed in the selection color. 

 

When you click in the end portion length edit box, the selection moves to the other side of the bending shape. 
When the hook is input, this visual indication is also automatically displayed at the end of the bending shape to which 
the active input in the additional toolbar relates. 
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Rebar / Meshes 

Special Meshes Create: Mesh Layer Determine 
When create a special mesh, you can now also determine a Mesh layer via the additional toolbar.  

 

Special Meshes Create: Local Coordinate System for Routing Direction 
When creating a special mesh, the local coordinate system is now visualized, which is saved for special mesh. If you 
want to route a special mesh afterward, it is important that you determine the x-direction of the special mesh over an 
object edge when you define the coordinate system so that it matches the later routing direction. 

Before you set the reference point / placement point of the special mesh, you can use the new toggle icon additional 
toolbar to determine the orientation of the special mesh in the coordinate system. 

 

You can inherit the active coordinate system of the special mesh or automatically determine the orientation of the 
coordinate system by traversing an object edge to determine the later routing direction. 

Toggle icon 

 

Alignment of the active coordinate system 

Set coordinate system automatically 

Select Alignment of the active coordinate system, determine the reference point / placement point of the special 
mesh. The active coordinate system of the model is taken over here and is now also displayed on the mouse cursor. 
This corresponds to the previous standard behavior during generation. 

Select Set coordinate system automatically, determine the edge for the alignment of the local x-axis. The edge 
marked in magenta (x-direction) determines the later laying direction (see Route Special Mesh During Insert, page 40). 
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Rename Special Mesh Afterwards 
The new Rename function in the Special meshes group lets you rename a special mesh in your model and edit it, 
such as changing its diameter or length. 

Important! 

This renaming does not affect the initial special mesh in the administration. 

 

 Rename special mesh 

Select the special mesh and then click the icon. The additional toolbar defaults to the old name and automatically 
increments the numeric value. You can accept or re-enter this name. When re-typed, the administration checks for 
name equality and sets the number value to 1 if necessary. 

Additional toolbar 

 

Route Special Mesh During Insert 
You can now also route a special mesh that you choose through the administration. Before you determine the new 
reference point, click the Laying icon in the additional toolbar. 

Additional toolbar 

 

Then select the edge incl. placement point (starting point for the laying) for the alignment and confirm with right click. 
Optionally, you can now use the additional toolbar to rotate the placed mesh around the 3 axes and confirm again with 
right click. Then select the laying section using two points or the edge. Now use the additional toolbar to determine the 
start and end spacing (concrete cover) of the laying and the overlap length. 

When you finish entering the laying, press right click. 
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Note: 

If a component is shorter than the laid special mesh, or if the last mesh protrudes from the component in the case 
of the laying of several special meshes, this mesh is cut off optically in a matching manner in the model. However, 
for calculating the schedules in the drawing and the export to PXML, this special mesh retains its geometry and 
also the same rebar item numbers as the untruncated special meshes. 

Object Data for Special Meshes 
The object data now display the properties of a special mesh and you can change them there. 

 

Export IFC of Special Meshes 
Save when using a 3D model or a component as an IFC file, the special meshes are now also output as shown in the 
model. In the case of export, the special mesh is exported with its properties, i.e. object-specific properties such as 
mesh type and mesh layer, welding density and edge thickness are taken over. Likewise, the IFC structure lists the 
individual steel rod assemblies with their reinforcing bars. 

The enveloping auxiliary object of the special mesh is not exported.  
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Embedded Parts 

Reload 3D Embedded Parts on Demand 
For an initial installation, fewer 3D embedded parts are installed so that the administration is not delayed. We now 
make the 3D embedded parts available for download on a server in different catalogs sorted by different manufac-
turers/suppliers.  

You can access the download in the administration of the 3D embedded parts via the icon Download 3D embedded 
parts in STRAKON format. The files are downloaded in STRAKON format directly into the current master data path. 

 

If you confirm this message, a list of manufacturers/suppliers will open: 
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If you select a manufacturer/supplier, a further dialog box will open with the categories and the corresponding product 
types: 

 

You can select one or more categories. After confirming with OK, the embedded parts are downloaded directly and 
saved to the currently selected master data path. A message appears informing you of the quantity of 3D embedded 
parts downloaded. 

 

In the same way, you can perform this download of 3D embedded parts in the 3D embedded parts > additional function 
toolbar: Download Center function. 


	STRAKON 2024 New Features
	Contents
	Installation Instruction
	Important Information
	Directory Synchronization
	Installation Requirements
	Installation Important

	Installation
	Initial Installation
	Update / Parallel Installation

	De-Energizing 
	Dongle Version Enable
	Module Enabling for the Computer
	Register Unlock Keys


	Important Information about Version 2024
	Configurations
	Settings
	Sync Cloud: Central Folder for "strako.db"
	Master Data Renamed / Expanded
	Material Administration: Space in Material Group


	3D - Modeling
	Cube
	General
	Tab Renamed / Expanded

	Accessibility
	New Key Commands

	"Objects" Tab
	Path and Blend Generation Adjusted / Profile Alignment Expanded During Insert
	Arc: Machining via Handles Extended / Unified

	"Shuttering Boards" Tab
	Screw Connection also Possible at T-Joints

	"BIM" Tab
	IFC Data Management: Using Property Sets
	IFC Data Management: Applying Property Sets / Properties Export Filter

	Create Stairs
	Riser Quantity Changes: Cube Reinforcement in the Head of Stairs Adjusts



	Project model
	General
	Ribbon / Tabs: Structured

	Cube Views Expanded
	Cube View: Edit Cube Views Exclusively 
	Tab Expanded 
	Dimensions Without Connections Remain Intact
	Delete/Correct Dimension Points Without Connection
	Move Dimension Text
	Dimensioning the Lines in the Cube View
	Dimensioning the Axes in the Cube View
	Visual Representation of the Axes in Each Cube View Determine


	Cube Reinforcement
	General
	Tab Expanded

	Accessibility
	New Key Commands

	Rebar
	Input Rebar: Leg Modification / Hook Input With Optical Marking

	Rebar / Meshes
	Special Meshes Create: Mesh Layer Determine
	Special Meshes Create: Local Coordinate System for Routing Direction
	Rename Special Mesh Afterwards
	Route Special Mesh During Insert
	Object Data for Special Meshes
	Export IFC of Special Meshes


	Embedded Parts
	Reload 3D Embedded Parts on Demand


